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About this book

This book provides information about setting up, installing, configuring, and working
with IBM® Fibre Array Storage Technology (FAStT) Storage Manager Version 8.21.
Operating system environments supported are Red Hat Linux® Versions 7.1 and
7.2, SuSE Linux Version 7.3, and TurboLinux Version 7.0.

This Installation and Support Guide is for system administrators. Use this guide to:

v Determine the hardware and software that are required to install the
storage-management software.

v Integrate the necessary hardware components into your network.

v Install the FAStT Storage Manager software.

v Upgrade controller firmware, if necessary.

v Identify storage-management features that are unique to your specific installation.

How this book is organized
Chapter 1, “Introduction” on page 1 provides an overview of IBM FAStT Storage
Manager Version 8.21 and describes storage-subsystem management methods,
configuration types, types of installations, and installation requirements.

Chapter 2, “Preparing for installation” on page 15 discusses preparing for a network
installation, including setting up a Dynamic Host Configuration Protocol/Boot
Protocol (DHCP/BOOTP) server, UNIX® Boot Protocol (BOOTP) server, or a Novell
NetWare server.

Chapter 3, “Installing software” on page 33 provides procedures for installing the
software in a standard (noncluster) environment.

Chapter 4, “Completing the installation” on page 39 discusses starting the Enterprise
Management window, downloading firmware, applying NVSRAM, adding devices,
and subsystem management tasks.

Chapter 5, “Linux operating-system support” on page 47 discusses Linux operating
system limitations.

Appendix A, “Storage subsystem/controller information record” on page 49 provides
a data sheet template that you can use to create a controller information record.

Appendix B, “Getting help and technical assistance” on page 51 provides
information about how to obtain help, service, or technical assistance.

Appendix C, “Notices” on page 53 provides product notices and trademark
information.
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Notices used in this book
This book contains the following notices designed to highlight key information:

v Notes: These notices provide important tips, guidance, or advice.

v Important: These notices provide information that might help you avoid
inconvenient or problem situations.

v Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.

Related publications
The following publications are available in Adobe Acrobat Portable Document
Format (PDF) on the IBM FAStT Storage Manager CD or go to
http://www.ibm.com/pc/support/.

v IBM FAStT Storage Manager Version 8.21 Installation and Support Guide for
Linux® (this book)

v IBM FAStT Storage Manager Version 8.21 Installation and Support Guide for
Microsoft Windows NT® and Windows® 2000

v IBM FAStT Storage Manager Version 8.21 Installation and Support Guide for
Novell NetWare

v IBM FAStT Remote Mirror Option Installation and User’s Guide

v IBM TotalStorage™ FAStT700 Fibre Channel Storage Server Installation Guide

v IBM TotalStorage FAStT700 Fibre Channel Storage Server User’s Guide

v IBM FAStT700 Fibre Channel Cabling Instructions

v IBM FAStT Host Adapter Installation and User’s Guide

v IBM FAStT FC-2 Host Bus Adapter Installation and User’s Guide

v IBM TotalStorage FAStT FC2-133 Host Bus Adapter Installation and User’s Guide

v IBM FAStT500 RAID Controller Enclosure Unit Installation Guide

v IBM FAStT500 RAID Controller Enclosure Unit User’s Guide

v IBM TotalStorage FAStT EXP700 Storage Expansion Unit Installation and User’s
Guide

v IBM Netfinity® Fibre Channel Cabling Instructions

v IBM FAStT200 and FAStT200 High Availability Storage Servers Installation and
User’s Guide

v IBM FAStT200 Fibre Channel Cabling Instructions

The following diagnostic publications might be of interest:

v IBM FAStT MSJ User’s Guide

v IBM Fibre Channel Hardware Maintenance Manual

v IBM Fibre Channel Problem Determination Guide

v IBM Fibre Channel Basic SAN Configuration Setup Guide
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In addition, the following IBM Redbooks™ might be of interest:

v Fibre Array Storage Technology, A FAStT Introduction

v Implementing Netfinity Disk Subsystems: ServeRAID™ SCSI, Fibre Channel, and
SSA

v Tuning Netfinity Servers for Performance: Getting the most out of Windows 2000
and Windows NT 4.0

v Netfinity Director: Integration and Tools

v Netfinity Clustering Planning Guide

You can download these Redbooks from http://www.ibm.com/redbooks/.
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Chapter 1. Introduction

This installation and support guide provides information for preparing, installing,
configuring, and starting the IBM FAStT Storage Manager Version 8.21 program.
Operating systems supported are Red Hat Linux version 7.1 and 7.2, SuSE Linux
Version 7.3, and TurboLinux Version 7.0.

Before you begin the installation of this product, consult the README.TXT file first.
The README file is located in the root directory of the installation CD. Go to the
http://www.ibm.com/pc/support IBM Web page for the latest installation and user
information about the storage-management software and hardware components.

When you finish the installation process, refer to the following online help systems.

v Enterprise Management window Help - Use this online help system to learn more
about working with the entire management domain.

v Subsystem Management window Help - Use this online help system to learn
more about managing individual storage subsystems.

You can access these help systems from within Storage Manager 8.21 Client. From
either an Enterprise Management or Subsystem Management window, click Help or
press F1.

After installing IBM FAStT Storage Manager Version 8.21, consider installing the
FAStT Management Suite Java™ (FAStT-MSJ) diagnostic program. You can use this
program to verify the status of the Fiber Channel connections before using the
storage subsystem. The program and the IBM FAStT MSJ User’s Guide are located
on the IBM FAStT Storage Manager Version 8.21 CD.

New features
This section describes the new premium features and standard features that are
part of the IBM FAStT Storage Manager Version 8.21 software. Your storage
subsystem firmware must be at version 5.2x.xx if you want to use any of the
features listed in this section. You must purchase the firmware upgrade option if
your controller firmware is at version 04.x or earlier.

The following two premium features are available after purchasing a premium
feature key:

v FlashCopy - FlashCopy is a premium feature that is part of the IBM FAStT
Storage Manager 8.21 software and is enabled by purchasing a premium feature
key. This feature supports the creation and management of FlashCopy logical
drives. A FlashCopy logical drive is a logical point-in-time image of another
logical drive, called a base logical drive, in the storage subsystem. A FlashCopy
is the logical equivalent of a complete physical copy, but you create it much more
quickly and it requires less disk space. Because a FlashCopy is a host
addressable logical drive, you can perform backups using the FlashCopy while
the base logical drive remains online and user-accessible. In addition, you can
write to the FlashCopy logical drive to perform application testing or both
scenario development and analysis. The maximum number of FlashCopy logical
drives allowed is one half of the total logical drives supported by your controller
model.

v Remote Mirror Option - The Remote Mirror Option is a premium feature that is
part of the IBM FAStT Storage Manager 8.21 software. This feature is enabled by
purchasing a premium feature key. The Remote Mirror Option is used for online,
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real-time replication of data between storage subsystems over a remote distance.
In the event of a disaster or unrecoverable error on one storage subsystem, the
Remote Mirror Option enables you to promote a second storage subsystem to
take over responsibility for normal input/output (I/O) operations. When the
Remote Mirror option is enabled, the maximum number of logical drives per
storage subsystem is reduced. For more information, refer to “Number of
supported logical drives” on page 13.

In addition to the new premium features, the storage-management software
includes the following new standard features:

v Dynamic logical-drive expansion - this feature enables you to increase the
capacity of an existing logical drive. You can use the free capacity of a logical
drive on an existing array, or add unconfigured capacity (new or unassigned
drives) to that array. You can expand a logical drive dynamically without losing
access to it, or to any other logical drives.

v 2048 logical drive support - this feature enables you to increase the number of
defined logical drives up to 2048 for each storage subsystem. The number of
logical drives will depend on your controller model. For more information, refer to
“Number of supported logical drives” on page 13.

v Storage Partitioning - this feature gives you support for up to 64 storage
partitions. Specifically, there is support for up to two host ports in each host and
up to eight ports in each host group (supporting a four-way host group of
dual-adapter hosts).

v Script Engine and Command Line Interface (CLI) Language - this feature
expands previous version support to include:

– Creation of and deletion of a FlashCopy logical drive.

– The setting of FlashCopy logical drive attributes.

– Supporting dynamic logical drive expansion for standard or repository logical
drives.

– Disabling or recreating of a FlashCopy.

– Creating or deleting of logical drive-to-LUN mappings.

– Uploading Read Link Status data from a storage subsystem to a comma
delimited file on a management station.

– Downloading a feature key file to a storage subsystem to enable a premium
feature.

v Read Link Status Diagnostic (RLS) - this feature enhances controller diagnostics
by enabling you to isolate the source of link problems on a Fibre Channel loop.
During communication between devices, RLS error counts are detected within
the traffic flow of the loop. Error count information is accumulated over a period
of time for every component and device on the loop. The controller sets the
baseline automatically; however, a new baseline is set manually through the
Read Link Status Diagnostics window.

v Redesigned user interface - this feature supports a more integrated process of
creating logical drives and then mapping them to hosts or host groups and logical
unit numbers to create storage partitions. The previous Storage Partitions window
is now a Mappings View that you can switch to from the Logical/Physical View.

In the Subsystem Management window, the Mappings View displays storage
partition topology such as the default and defined host groups, hosts, host ports
in a tree, and FlashCopy logical drives.

v Controller default IP address - Unless a static IP address is assigned to the
controller by the administrator, controllers A and B will automatically be assigned
the following IP addresses:
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– Controller A (192.168.128.101)

– Controller B (192.168.128.102)

The subnet mask for the default IP address is 255.255.255.0.

v Support for IBM TotalStorage FAStT EXP700 Storage Expansion Unit
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Supported machine types
Table 1 provides a list of machine types and supported storage-management
software.

Table 1. Machine type and supported storage-management software

Product name Machine
type

Model Product release
and firmware

version

Supported
storage-

management
software
version

IBM FAStT200 Storage
Server

3542 1RU 1RX 4.x, 5.20.xx.xx 7.10, 8.0, 8.2,
8.21

IBM FAStT200 High
Availability Storage Server

3542 2RU 2RX 4.x, 5.20.xx.xx 7.10, 8.0, 8.2,
8.21

IBM FAStT500 RAID
Controller Enclosure Unit

3552 1RU 1RX 4.x, 5.00.xx.xx
5.20.xx.xx
5.21.xx.xx

7.10, 8.0, 8.2,
8.21

IBM TotalStorage FAStT700
Fibre Channel Storage
Server

1742 1RU 1RX 5.00.xx.xx
5.20.xx.xx
5.21.xx.xx

8.0, 8.2, 8.21

Note: Storage subsystem firmware must be at version 04.01.02.07 or later to be
managed with Storage Manager 8.21.

Terms to know
If you are upgrading from a previous version of the IBM FAStT Storage Manager
software, you might find that some of the terms you are familiar with have changed.
It is important that you familiarize yourself with the new terminology. Table 2
provides some of the old and new terms.

Table 2. New terminology

Term used in previous versions New term

RAID module Storage subsystem

Drive group Array

Volume Logical drive

It is important to understand the distinction between the following two terms when
reading this document:

Management station
A management station is a system that is used to manage the storage
subsystem. It can be attached to the storage subsystem in the following
ways:

v Through a Transmission Control Protocol/Internet Protocol (TCP/IP)
Ethernet connection to the controllers in the storage subsystem.

v Through a TCP/IP network connection to a host computer with
host-agent software installed on it, which in turn is directly attached to
the storage subsystem through the Fibre Channel input/output (I/O) path.
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Host computer
A host computer is a system that is directly attached to the storage
subsystem through a Fibre Channel I/O path. This system is used to do the
following:

v Serve data (typically in the form of files) from the storage subsystem

v Function as a connection point to the storage subsystem for a
remote-management station

Notes:

1. All Linux operating systems are referred to in this book as Linux unless
otherwise noted for installation procedures that might be operating
system specific.

2. The terms host and host computer are used interchangeably throughout
this book.

3. A host computer can also function as a management station.

IBM FAStT Storage Manager 8.21 software
Storage Manager Version 8.21 contains the following software packages for Linux
environments:

v Storage Manager 8.21 Client (SMclient)

v Storage Manager 8.21 Runtime (SMruntime)

v Storage Manager 8.21 Utility software (SMutil)

v IBM FAStT Management Suite Java (FAStT MSJ)

v IBM Host Adapter device drivers (qla2200.o and qla2300.o)

Storage Manager Version 8.21 Client
The Storage Manager Version 8.21 client (SMclient) component provides the
graphical user interface (GUI) for managing storage subsystems through the
Ethernet network or from the host. The SM8client contains two main components:

v Enterprise Management. You can use the Enterprise Management component
to add, remove, and monitor, storage subsystems within the management
domain.

v Subsystem Management. You can use the Subsystem Management component
to manage the components of an individual storage subsystem.

Storage Manager 8.21 Runtime
The Storage Manager 8.21 Runtime (SM Runtime) package contains the software
JAVA Runtime for the SMclient and SMutil packages.

Storage Manager 8.21 Utility
Use the Storage Manager 8.21 utility (SMutil) software package to register and map
new logical drives to the operating system. You can use the SMdevices utility to
associate storage subsystem-logical drives with operating system device names.

IBM FAStT Host Adapter device driver
The IBM FAStT Host Adapter device drivers (qla2200.o and qla2300.o) enables
your operating system to communicate with the host adapter. The IBM TotalStorage
FAStT FC2-133 Host Bus Adapter is a high-performance, direct memory access
(DMA), bus-master, host adapter designed, for high-end systems. The IBM FAStT
Host Adapter supports all Fibre Channel (FC) peripheral devices that support
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private-loop direct attach (PLDA) and fabric-loop attach (FLA). Refer to the IBM
TotalStorage FAStT FC2-133 Host Bus Adapter Installation and User’s Guide or go
to the http://www.ibm.com/pc/support IBM Web page for the current README file
and latest multipath I/O device drivers.

IBM FAStT Management Suite Java
The IBM FAStT Management Suite Java (FAStT MSJ) is part of the IBM FAStT
Storage Manager software package. It provides multipath I/O device drivers for
Linux. Based on a driver that resides on top of the hardware driver, the IBM FAStT
Management Suite Java can be configured with a preferred and an alternate path
for every logical drive. In case of a failure along the I/O path, the driver will send
the I/O requests through the alternate path and Auto-Volume Transfer (AVT) will
move the logical drive within the FAStT Storage Server. The IBM FAStT
Management Suite Java agent (qlremote) is installed on the Linux system, which
then can be configured from a management station running the IBM FAStT
Management Suite Java.

Refer to the IBM FAStT MSJ User’s Guide for the diagnostics installation procedure
for Linux.

Managing the storage subsystem
You must manage storage systems using direct (out-of-band) management. You are
then managing storage subsystems directly over the network through an Ethernet
connection to each controller. To manage the storage subsystem through the
Ethernet connections, you must define the IP address and host name for each
controller and attach a cable to the Ethernet connectors on each of the storage
subsystem controllers, as shown in Figure 1 on page 7.

Management of storage subsystems using the direct (out-of-band) management
method has the following advantages:

v The Ethernet connections to the controllers enable a management station
running SMclient to manage storage subsystems that are connected to a host
running any of the operating systems that are supported by Storage Manager
8.21.

v You do not need to use an access logical drive to communicate with the
controllers. You can configure the maximum number of logical drives that are
supported by the operating system and the host adapter that you are using.

Managing storage subsystems using the direct (out-of-band) management method
has the following disadvantages:

v Two Ethernet cables are required to connect the storage subsystem controllers to
a network.

v When adding devices, you must specify an IP address or host name for each
controller.

v A DHCP/BOOTP server and network preparation tasks are required. For a
summary of the preparation tasks, see “Preparing a network installation” on
page 15.

You can avoid DHCP/BOOTP server and network tasks by assigning static IP
addresses to the controller, or by using a default IP address.

v To assign a static IP addresses, see the IBM support Web site for Retain Tip
#H171389 Unable To Setup Networking Without DHCP/BOOTP.
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v If the storage subsystem controllers have firmware version 05.00.xx. or later, they
have the following default settings:

Note: If the storage subsystem controllers have firmware version 5.2x.xx.xx, they
have the following default settings:

Controller IP address Subnet mask

A 192.168.128.101 255.255.255.0

B 192.168.128.102 255.255.255.0

Figure 1 shows a system in which storage in which subsystems are managed using
the direct (out-of-band) management method.

Ethernet

Host computer

Fibre Channel
I/O path

Management station
(one or more)

Controller

Controller

Controller

Controller

Storage subsystems

Where to install the software components
You will need to install the software components on management stations and host
computers.

Management stations
You must install the following software components on each management station:

v Storage Manager 8.21 Client (SMclient)

Figure 1. Direct (out-of-band) managed storage subsystems
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v IBM FAStT Management Suite Java (FAStT MSJ)

v Storage Manager 8.21 Runtime (SMRuntime)

Host computers
You must install the following software components on each host computer:

v IBM FAStT Management Suite Java (FAStT MSJ)

v IBM FAStT Host Management Suite Java agent (qlremote)

v IBM FAStT Host Adapter device driver

v Storage Manager 8.21 Runtime (SMRuntime)

v Storage Manager 8.21 Client

v Storage Manager 8.21 Utility

The SMclient must be installed on a host computer if you intend the host computer
to act as a management station. If the host computer is not connected to a network,
it must have TCP/IP software installed, and you must assign an IP address to the
host.

Ethernet

Host computer
Controller

Controller Fibre Channel
I/O path

Management station
FAStT MSJ, SMclient,

and SMRuntime

FAStT MSJ, FAStT HA
device driver, storage
manager utility, QL Remote,
SMRuntime, and SMclient

The client software is
installed on one or more

management systems,
or on the host computer.

Storage subsystems

Installation types
You can install the storage-management software in two types of hardware
environments:

v New storage subsystem environment. You are installing the IBM TotalStorage
FAStT Fibre Channel Storage Server using firmware 5.2x.xx and you will manage
storage subsystems using Storage Manager 8.21.

v Existing storage subsystem environment. You are installing the
storage-management software in an environment with existing storage

Figure 2. Sample software installation
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subsystems. See Table 3 for your installation options in an environment with
existing storage subsystems.

Table 3. Configurations for existing storage subsystems

Existing storage subsystems
with:

Options

Machine type 3542, 3552,
controllers running firmware
version 04.01.02.07 through
04.01.xx.xx.
Note: If you have a level of
firmware that is earlier than
04.01.02.07, you cannot use Red
Hat Linux as your operating
system.

Option 1 —Upgrade the controller firmware to version
5.2x.xx.xx and manage the storage subsystems with
Storage Manager 8.21. You might need to purchase
additional firmware.

Option 2 —Install new storage subsystems and attach
them to the same host as the existing storage
subsystems. These existing and new storage
subsystems are referred to as coexisting storage
subsystems. See “Managing coexisting storage
subsystems” for more information.

Managing coexisting storage subsystems
Storage subsystems are coexisting storage subsystems when the following
conditions are met:

v There are multiple storage subsystems with controllers running different versions
of firmware.

v These storage subsystems are attached to the same host.

For example, a coexisting situation exists when you have a new storage subsystem
with controllers running firmware version 5.2x.xx.xx, and it is attached to the same
host as one or more of the following configurations:

v A storage subsystem with controllers running firmware versions 04.01.02.07
through 04.01.xx.xx, which is managed by a separate management station with
Storage Manager 7.02.

v A storage subsystem with controllers running firmware versions 04.01.02.07
through 04.01.xx.xx, which is managed with Storage Manager 8.21.
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Figure 3 shows an example of an environment that includes coexisting storage
subsystems.

Ethernet

Host computer

Controller

Controller

Controller

Controller

Fibre Channel
I/O path

Management station
(one or more)

Management station
(one or more)

Host-agent

Client software
Storage subsystems

Firmware version
4.01.x (minimum)

Firmware version 5.x

Version 8.21 of the
storage-management client
software must be installed on either
a management station or host.

Storage subsystems

System requirements
This section provides detailed information about the hardware, software, and
operating system requirements for Storage Manager Version 8.21.

Hardware requirements
Table 4 on page 11 lists the hardware that is required for installing Storage Manager
8 in a Linux environment. For the latest information about host adapters and host
adapter device drivers, see the README file on the IBM FAStT Storage Manager
Version 8.21 installation CD or go to http://www.ibm.com/pc/support.

Figure 3. Sample coexistence installation
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Table 4. Hardware requirements for Storage Manager 8.21 software

Hardware component Requirements

A BOOTP server v UNIX
®

BOOTP server

v Microsoft Windows 2000 BOOTP-compatible DHCP server

v NetWare DHCP server

Storage subsystems (one or
more)

Storage subsystems with controllers running firmware version
04.01.xx.xx
Note: Read “Installation types” on page 8 for information on
managing these storage subsystems when existing storage
subsystems are physically connected to the same host that you
will connect to the new storage subsystems.

Fibre Channel host adapters The following Fibre Channel host adapters were tested with the
storage-management software:

v IBM FAStT host adapter (part number: 00N6881)

v IBM FAStT FC-2 host bus adapter (part number: 19K1246)

v IBM TotalStorage FAStT FC2-133 host bus adapter (part
number: 24P0960)

For information on specific host adapter requirements:

v Refer to the README file in the \linux\Host_Adapter
directory on the installation CD.

v Read the host adapter documentation.

v Go to the http://www.ibm.com/pc/support Web site

Fibre Channel fabric
switches (if needed for your
configuration)

The following Fibre Channel fabric switches were tested with
the storage management software:

v IBM 8-port Fibre Channel switch (machine type: 2109-S08)

v IBM 16-port Fibre Channel switch (machine type: 2109-S16)

v IBM 16-port 2 Gbps Fibre Channel switch (machine type:
2019-F16)

v IBM 8-port 2 Gbps Fibre Channel switch (machine type:
3534-F08)

For specific Fibre Channel switch setup requirements:

v Read the switch documentation

v Go to the http://www.ibm.com/storage/fcswith Web site

Fibre Channel managed
hub (if needed for your
configuration)

The IBM Fibre Channel managed hub (machine type: 3534)
has been tested with the storage-management software.

For specific Fibre Channel managed hub setup requirements:

v Read the documentation that comes with your managed
hub.

v Go to the http://www.ibm.com/storage/fchub Web site
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Table 4. Hardware requirements for Storage Manager 8.21 software (continued)

Hardware component Requirements

Management station (for
client software)

Your management station computer will require:

v Intel® Pentium® or Pentium-equivalent microprocessor (133
MHz or faster)

v CD-ROM drive

v Mouse or similar pointing device

v A minimum of 128 MB system memory

v Ethernet network interface adapter

v AGP or PCI video adapter (AGP preferred), ISA adapters
are not supported

v Monitor setting of 1024 x 768 pixels with 64,000 colors. The
minimum display setting that is allowed is 800 x 600 pixels
with 256 colors.

v 60 MB of free hard disk space

v Ethernet network interface adapter

v Hardware-based Windows acceleration: Desktop computers
that use system memory for video memory are not preferred
for use with the storage-management software.

Important: Many PC-based servers are not designed to run
graphic-intensive software. If your server has difficulty running
the storage-management software smoothly without video
artifacts, you might need to upgrade the server video adapter.

Firmware requirements
To utilize all the features of Storage Manager 8.21, your storage subsystem must
contain controllers with firmware version 5.2x.xx.xx. To manage storage subsystems
with Storage Manager 8.21, your existing storage subsystems must contain
controllers with firmware versions 5.2x.xx.xx or higher. If you want to upgrade from
firmware versions 04.01.xx.xx (or higher) to 5.2x.xx.xx, an optional firmware
upgrade is available for purchase (for machine type 3552 only). For more
information, contact your IBM service representative.

Software requirements
Table 5 lists the disk space and administrator privilege required for installing version
8.21 of the storage-management software in a Linux environment.

Table 5. Installation requirements by software package

Package Disk space requirement

Storage Manager 8.21 Client (SMclient) 15 MB on /opt 2 MB on /tmp

IBM FAStT Management Suite Java (FAStT MSJ) 35 MB

Storage Manager 8.21 Utility (SMutil) 7 MB on/opt

IBM Host Adapter device driver 1 MB

Storage Manager 8.21 Runtime (SMRuntime) 42 MB on/opt 1 MB on/var
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Operating system requirements
Each management station or host computer requires the following minimum
operating system and kernel levels:

Operating system Kernel

Red Hat Linux Versions 7.1 and 7.2 2.4.9-21

SuSE Linux Version 7.3 2.4.10

TurboLinux Version 7.0 2.4.9-3

Red Hat Advanced Server 2.1 2.4.9-E.3

Red Hat Linux Version 7.3 2.4.18-5

Note: There are limits on how many logical unit numbers (LUNs) you can use to
access the logical drives on a single storage subsystem. Supported logical
drive limits for Red Hat Linux version 7.1 are 128 maximum with 32 LUNs
per storage partition.

Number of supported logical drives
There is a limit to how many logical unit numbers (LUNs) can access the logical
drives on a single storage subsystem. The maximum number of logical drive that a
FAStT storage subsystem supported with firmware version 5.2x.xx.xx depends on
the model of the FAStT storage subsystem.

Table 6. Logical drives without the remote mirror option enabled

Model
Type

Maximum logical drives Maximum logical drives
per storage unit partition

Maximum flashCopy
logical drives

3542 5121 325 2562

3552 5121 325 2562

1742 20481 325 10242

Table 7. Logical drives using the remote mirror option

Model Type Maximum logical
drives

Maximum logical drives
per storage unit partition

Maximum flashCopy
logical drives

3542 N / A N / A N / A

3552 1283,6 325 642

1742 2561,4,6 325 1282

Note: The access logical drive is also referred to as the Universal Xport Device.

1.When using firmware version 5.xx.xx, the firmware reserves one logical drive for
use by the system.

2. Maximum of four FlashCopy logical drives for each standard logical drive

3. Maximum of eight remote mirror pairs

4. Maximum of 16 remote mirror pairs
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5.The host-agent management method uses a special logical drive, called an access
logical drive, to communicate with the controllers on the storage subsystem. The
access logical drive uses one of the available LUNs. Therefore, managing storage
subsystems with the host-agent software limits you to one fewer LUN than the
maximum number supported by the operating system and the host adapter.

6.For firmware version 5.2x.xx.xx, the maximum number of logical drives includes
the flashcopy repository logical drives and the remote mirror logical drives, in
addition to the standard data logical drives. If the remote mirror option is enabled,
two logical drives are reserved for use by the system.
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Chapter 2. Preparing for installation

This chapter provides information to help you plan for the installation of the
storage-management software.

Reviewing a sample network
The example in Figure 4 shows a direct-managed storage subsystem. Network A
contains the following components:

v DHCP BOOTP server

v Network Management Station (NMS) for Simple Network Management Protocol
(SNMP) traps

v Host that is connected to a storage subsystem through a Fibre Channel I/O path

v Management station connected by Ethernet cable to the storage subsystem
controllers

Controller

Controller

Storage
subsystem

finance

Fibre Channel
I/O path

Network A
TCP/IP Ethernet

Network
management

station
(for SNMP traps)

Management
station

(one or more)

Host computer
Denver

(IP address
192.168.128.100)

BOOTP server

Host name: Denver_a
(IP address )

hardware address 00.a0.b8.02.04.20
192.168.128.101

Host name: Denver_b
(IP address )

hardware address 00.a0.b8.00.00.d8
192.168.128.102

Preparing a network installation
To begin installing the storage-management software, ensure that the network
components are set up and operating properly, and that you have all the host and
controller information needed for the software to operate correctly.

The following list provides a high-level overview of the tasks involved in setting-up a
network installation.

Step 1. Install all hardware components (host computers, storage subsystems, and
cables) that you want to connect to the network. You might need to refer to
the installation guide specific to the hardware components for proper
installation.

Step 2. Establish a naming convention for the storage subsystems connected to
the network. Refer to “Naming the storage subsystems” on page 16 for
more information.

Figure 4. Sample network when using direct-managed storage subsystems
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Step 3. Record the storage subsystem names and management types in Table 12
on page 49. An example of a completed information record is shown in
Table 8.

Note: Throughout the remaining steps, you will need to return to Table 12
on page 49 to record information such as hardware Ethernet
addresses and IP addresses.

Step 4. Determine the hardware Ethernet addresses for each controller in storage
subsystems that are connected to the network. Refer to “Identifying the
hardware Ethernet MAC address for each controller” on page 17 for more
information.

Step 5. Obtain the following information from the network administrator. The IP
address of each controller in the storage subsystems is to configure the
DHCP BOOTP server. Refer to “Assigning IP addresses for hosts and
controllers” on page 20 for more information.

Step 6. Set up the DHCP BOOTP server to provide network configuration
information for a specific controller.

Step 7. Verify that the TCP/IP software is installed, and set up the host or DNS
table. Installing the client software on a management station ensures that
the management station is configured to reach the controllers over the
network.

Step 8. Power on the devices connected to the network.

Table 8 shows a sample information record for a direct-managed storage subsystem
and a host-agent managed storage subsystem.

Table 8. Sample information record

Storage
subsystem
name

Management
type

Controllers—Ethernet and IP
addresses, and host name

Host—IP
address and
host nameController A Controller B

Finance Direct Hardware
Ethernet address
= 00a0b8020420

Hardware
Ethernet address
= 00a0b80000d8

IP address =
192.168.128.101

IP address =
192.168.128.102

Host = Denver_a Host = Denver_b

Naming the storage subsystems
As you set up your network, decide on a naming convention for the storage
subsystems. When you install the storage-management software and start it for the
first time, all storage subsystems in the management domain are displayed as
<unnamed>. Use the Subsystem Management window to rename the individual
storage subsystems.

Consider the following when naming storage subsystems:

v There is a 30-character limit. All leading and trailing spaces are deleted from the
name.

v Use a unique, meaningful naming scheme that is easy to understand and
remember.

v Avoid arbitrary names or names that might quickly lose their meaning.
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v The software displays storage-subsystem names with the prefix Storage
Subsystem. Therefore, if you rename a storage subsystem to Finance, it is
displayed as:
Storage Subsystem Finance

If you plan to manage your storage subsystem using the direct-management
method, go to “Identifying the hardware Ethernet MAC address for each controller”.
If you plan to manage your storage subsystem using the host-agent management
method, go to “Assigning IP addresses for hosts and controllers” on page 20.

Identifying the hardware Ethernet MAC address for each controller
To manage your storage subsystem using the direct-management method, you
need to identify the Ethernet MAC address for each controller.

To identify the hardware Ethernet MAC address for machine type 3542, do the
following:

1. Locate the Ethernet MAC address at the back of the unit, under the controller
Gigabit Interface Converter (GBIC) ports, as shown in Figure 5. The number will
be in the form xx.xx.xx.xx.xx.xx (for example, 00.a0.b8.20.00.d8).

2. Record each Ethernet address in the information record (Table 12 on page 49).

Hardware Ethernet
address label

To identify the hardware Ethernet MAC address for machine types 3552 and 1742,
do the following:

1. Remove the front bezel from the controller unit, as shown in Figure 6 on
page 18. Carefully pull the bottom of the bezel out �1�to release the pins; then,

Figure 5. Locating the Ethernet MAC address for machine type 3542
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slide the bezel down �2�.

2. On the front of each controller, look for a label with the controller hardware
Ethernet address. The number will be in the form xx.xx.xx.xx.xx.xx (for example,
00.a0.b8.00.00.d8).

3. Record each Ethernet address in the information record (Table 12 on page 49).

4. To replace the bezel, slide the top edge under the lip on the chassis �1�; then,
push the bezel bottom until the pins snap into the mounting holes �2�, as shown
in Figure 7 on page 19.

Figure 6. Removing the controller-unit bezel (machine types 3552 and 1742)
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5. Continue with “Assigning IP addresses for hosts and controllers” on page 20.

Figure 7. Replacing the controller-unit bezel (machine types 3552 and 1742)
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Assigning IP addresses for hosts and controllers
If you plan to manage our storage subsystem using the direct-management method,
assign a unique IP address for each host and controller in all storage subsystems
on the network. Record the IP address for each controller in the information record
(Table 12 on page 49). Then, go to “Setting up the DHCP or BOOTP-compatible
server”.

Note: If you want to assign static IP addresses for the controllers, refer to the IBM
support Web site for Retain Tip #H171389 ″Unable To Setup Networking
Without DHCP/BOOTP″. Then, go to “Verifying the TCP/IP protocol and
setting up the host or DNS table” on page 31.

If you plan to manage your storage subsystem using the host-agent management
method, assign an IP address for each host on which you will instal the host-agent
software. Record the IP address for each host in the information record (Table 10
on page 45). Then, go to “Verifying the TCP/IP protocol and setting up the host or
DNS table” on page 31.

Setting up the DHCP or BOOTP-compatible server
To directly manage storage subsystems through the Ethernet connection to each
controller, you will need to set up a DHCP or BOOTP-compatible server and
configure the following options:

v Router/Gateway

v DNS Server

v Host name

v DNS Domain Name

This section provides instructions for setting up a DHCP server on Windows NT,
Windows 2000, and Novell NetWare, as well as instructions for setting up a UNIX
BOOT server.

Note: The remote management station (RMS) and network management station
(NMS) entries used in previous versions of the storage-management
software are not required when using Storage Manager Version 8.2.

Setting up a Windows NT DHCP server
You must use a version of DHCP that supports BOOTP static addressing. To use a
DHCP server, you must have a DHCP Manager installed. If a DHCP Manager is
installed on the system, go to “Setting up a DHCP server” on page 21. If a DHCP
Manager is not installed, use the following installation procedure to install one.

Installing the DHCP Manager
Use the following procedure to install the DHCP Manager:

1. Click Start → Settings → Control Panel.

2. Click Network. The Network window opens.

3. Click Services.

4. From the Services tab, click Add.

5. Click Microsoft DHCP Server; then, click OK.

6. Specify the path to the Windows NT Install file; then, click Continue. A
dialogue windows opens, stating that a static IP address is required.

7. Click OK. The Network window opens.
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8. Click Protocols.

9. Click TCP/IP Protocol; then, click Properties.

10. Verify that the IP address information is correct; then, click OK.

11. Continue to “Setting up a DHCP server”.

Note: After installing the DHCP Manager, you can refer to its online help for
additional information.

Setting up a DHCP server
Use the following procedure, along with the information you recorded in Table 12 on
page 49, to set up a DHCP server.

1. Click Start → Programs → Administrative Tools → DHCP Manager. The DHCP
Manager window opens.

2. Create a scope. A scope defines a group of controllers that you want to
configure using the DHCP server.

a. Click Local Machine.

b. Click Scope → Create. The Create Scope - (Local) window opens.

c. Type the starting and ending IP addresses of the controllers that you are
configuring for the network.

For example, if you are configuring 50 controllers on a 153.79.144.0 subnet,
set the starting address to 153.79.144.1 and the ending address to
153.79.144.50.

Note: If each field does not contain at least three characters, press the
period (.) key to advance to the next field. If you have only one
controller, type its address for both the starting and ending address.

Figure 8. Create Scope - (Local) window
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d. Type the subnet mask (obtained from your network administrator).

e. Set the Lease Duration to Unlimited. This makes the DHCP connection
permanent.

f. Type a scope name and comment.

g. Click OK.

h. When the scope successfully completes, click Yes to activate it. This returns
you to the DHCP Manager window.

3. Configure global scope options. Table 7 shows the global options that need to
be set.

Table 9. Global options for a Windows NT DHCP server

Number Description Notes

003 Router/Gateway

006 DNS Server

012 Host name Unique for each controller

015 DNS domain name For example, ibm.com

You can apply options to specific controllers later using step 5 on page 23.

a. Click DHCP Options → Global. The DHCP Options: Global window opens.

b. To make a global option active, select an item in the Unused Options list;
then, click Add to move it to the Active options list.

c. Click Value to assign a value to the active option.

If the Value field is not available, click Edit Array; the Edit Array Editor
window opens. Do one of the following:

v If you need to add an IP address, complete the following procedure:

Figure 9. DCHP Options: Global window
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1) Click Edit Array. The IP Address Array Editor window opens.

2) Type a unique IP address for the option that you added.

3) Click Add to move the New IP Address to the IP Addresses list.

4) Click OK. This returns you to the DHCP Options: Global window.

v If you do not need to add an IP address, click Cancel. This returns you to
the DHCP Options: Global window.

d. Repeat step 3b through step 3c on page 22 until all global options are
added.

e. When you finish adding the Global Scope Options, click OK at the DHCP
Options: Global window.

4. Create a reservation for each controller. Use the information record (Table 12 on
page 49) to make sure that you include all of the controllers on the network.

a. Click Scope → Add Reservations.

b. In the IP Address field, type the IP address for the first controller on your
data sheet.

c. In the Unique Identifier field, type the controller hardware Ethernet address.
Do not type decimal points or spaces.

d. In the Client Name field, type the controller eight-character name.

e. Click Add.

f. Repeat step 4b through step 4e for each controller that is listed on
information record (Table 12 on page 49).

g. When you finish adding the information for all of the controllers, click Close.
This returns you to the DHCP Manager window.

5. Configure controller-specific options. By creating a controller-specific option, you
can associate a controller configuration entry with a specific controller.

Note: If you set an option as Global Scope, it applies to every controller in this
group and does not need to be added again.

Figure 10. IP Address Array Editor window
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a. Click Scope → Active Leases. The Active Leases window opens.

b. Select a controller in the list.

c. Click Properties. The Add Option Type window opens. The Unique Identifier
is the hardware Ethernet address from step 4c.

d. Click Options. The DHCP Options: Reservations window opens.

e. Select an option from the Unused Options list, and click Add to move it to
the Active Options list.

f. Click Value to assign a value to the active option.

g. Type the information for the value of the option. For example, type the host
name for the controller from your information record (Table 12 on page 49) in
the String field. Click Edit if the value that you need to add is an IP address
for a router.

Figure 11. Active Leases window

Figure 12. Add Option Type window
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h. Repeat step 5e through step 5g until you finish adding specific options for
this controller.

i. Click OK. This returns you to the Add Option Type window.

j. Click OK. This returns you to the Active Leases window.

k. Repeat step 5b through step 5j until you finish adding controller-specific
options for every controller.

l. Click OK on the Active Leases window. This returns you to the DHCP
Manager window.

6. Do the following to add a network management custom option:

a. From the DHCP Manager window, select a scope; then, select DHCP
Options: Defaults. The DHCP Option: Defaults window opens.

b. In the Name field, type Network Management Station.

c. In the Data Type field, select IP Address; then, select the Array check box.

d. In the Identifier field, type 165.

e. In the Description field, type a description of the SNMP servers to which
the controllers will send alerts.

f. Click OK.

7. Continue with “Verifying the TCP/IP protocol and setting up the host or DNS
table” on page 31.

Setting up a Windows 2000 DHCP server
You must use a version of DHCP that supports BOOTP static addressing. To use a
DHCP server, you must have a DHCP Manager installed. If a DHCP Manager is
installed on the system, go to “Setting up a DHCP server” on page 21.

Installing the DHCP Manager
To install the DHCP Manager, do the following:

1. Click Start → Administrative Tools → Configure Your Server. The Configure
Your Server window opens.

2. In the left pane, double-click Networking; then, click DHCP

3. In the right pane, click Start. The Windows Components Wizard starts.

4. In the Components field, select Networking Services; then, click Details.

Note: Do not select the check box; you do not want to install all of the
Networking Services subcomponents.

The Networking Services window opens

5. In the Subcomponents of Networking Services field, select Dynamic Host
Configuration Protocol (DHCP).

6. Click OK; the Windows Components Wizard window opens.

7. Click Next to start the installation process.

8. If prompted, type the full path to the Windows 2000 distribution files and click
Continue.

9. When the installation has successfully completed, the Configure Your Server
Window opens.

10. Click Next.

11. Click Open the DHCP Manager. The DHCP window opens.

12. Continue with step 2 on page 26. of “Setting up a DHCP server” on page 21.

Note: After installing the DHCP Manager, you can refer to its online help for
additional information.
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Setting up a DHCP server
Use the following procedure to create a scope and to set up a DHCP server. A
scope defines a group of controllers by their IP addresses. You must create and
configure a scope so that dynamic IP addresses can be assigned to controllers on
your network. Refer to the information record (Table 12 on page 49). Before you
begin, read through the instructions to determine what information is required; then,
request the information from your network administrator.

1. Click Start → Programs → Administrative Tools → DHCP. The DHCP window
opens.

2. In the Console tree, right-click the server you want to configure; click New
Scope. The New Scope Wizard starts.

3. Follow the on-screen instructions to define the scope of IP addresses for
TCP/IP clients. You will define the following:

a. Scope name and description

b. IP address range for the controllers you are configuring and the subnet
mask

c. IP addresses that you want to exclude from the IP address range

d. IP address lease duration

e. Common DHCP options:

v IP address for a router

v Domain name and DNS servers

4. When you have defined the scope, click Yes, I want to activate this scope
now. The wizard ends, and the DHCP window appears.

5. In the Console tree, open the scope folder.

6. Right-click Reservations; then, select New Reservations. The New
Reservations window opens.

7. To define the IP address reservation, type the following information:

Figure 13. New Scope Wizard: IP Address Range window
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a. Reservation name

b. IP address

c. Ethernet hardware MAC address

d. Description

8. In the Supported Type field, select Both (DHCP and BOOTP).

9. Click Add.

10. Repeat steps 5 through 9 for each controller in the network.

11. Restart the DHCP server and then restart the storage subsystem so that all
modifications are applied.

12. Go to “Verifying the TCP/IP protocol and setting up the host or DNS table” on
page 31.

Setting up a NetWare DHCP server
A NetWare DHCP server automatically assigns IP addresses and other
configuration information to clients upon request or when the clients are restarted.

To set up a NetWare DHCP server, you must complete the following tasks:

1. Install DNS/DHCP Services, either during or after installing NetWare 5.

2. Install the DNS/DHCP Management Console.

3. Create the DHCP server object.

4. Create the subnet address.

5. Create the subnet address range.

6. Create the IP address object.

7. Start the DHCP server.

Installing NetWare 5.1 with DNS/DHCP Services
This section contains instructions for adding Novell DNS/DHCP services during and
after the NetWare 5.1 installation.

Adding Novell DNS/DHCP Services during the NetWare 5.1 installation: Do
the following to add Novell DNS/DHCP Services during the Netware 5.1 installation:

1. From the Installation Options window, select Custom.

2. From the Components window, select the Novell DNS/DHCP Services check
box.

3. Follow the on-screen instructions to complete the NetWare 5.1 installation.

Adding Novell DNS/DHCP Services after the NetWare 5.1 installation: Do the
following to add Novell DNS/DHCP Services after the Netware 5.1 installation:

1. Insert the NetWare 5.1 Installation CD into the CD-ROM drive; then, mount the
CD as a volume.

2. Load NWCONFIG and select Product Options.

3. Select Install a Product not Listed.

4. Press F3 and specify the volume name of the CD. The X Server-Graphical
Console window opens.

5. In the Additional Products and Services dialog box, select the Novell
DNS/DHCP Services check box.

6. Follow the on-screen instructions to complete installation.

Note: Installing the DNS/DHCP Service will extend the Novell Directory
Services (NDS) schema and create the following NDS objects:
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v DNSDHCP-GROUP Group object

v DNS/DHCP Locator object

v RootServerInfo Zone object

Installing the DNS/DHCP Management Console
Do the following to install the DNS/DHCP Management Console and NetWare
Administrator snap-in files on the client workstation you will use to administer DNS
and DHCP:

1. If you have not already done so, install the latest version of Novell Client 32 on
your workstation.

2. From the workstation, run the SYS:PUBLIC\DNSDHCP\SETUP.EXE program.

3. Install the DNS/DHCP Management Console on the local hard-disk drive.

4. Install the NetWare Administrator snap-in files in the SYS:PUBLIC\WIN32
directory.

5. Restart the workstation.

6. To start the DNS/DHCP Management Console, double-click the shortcut icon on
the desktop, enter the NDS Tree NAME, and click Launch.

Note: You can install the DNS/DHCP Management Console on a workstation, or
you can access it from the Tools menu of the NetWare Administrator utility.

Creating the DHCP server object
Use the DHCP Management Console to create a DHCP server object. A DHCP
server object can be created under any of the following objects:

v Organization (O)

v Organization Unit (OU)

v Country (C)

v Locality (L)

Do the following to create a DHCP server object:

1. From the DHCP Management Console, click the DHCP Service tab.

2. In the left pane, select Our Network.

3. Click Create. The Create New DHCP Object window opens.

4. Select DHCP Server; then, click OK. The Create DHCP Server window opens.

5. Select a server; then, click Create. This creates the DHCP server object in
NDS, called DHCP_servername.

6. In the DHCP Management Console, locate the icon for the DHCP server object
at the bottom of the DHCP Service tab. The server object is displayed with a
red line through it. The red line indicates that DHCP server has not been
started.

7. Continue with “Creating a subnet object”.

Creating a subnet object
You must do the following to create a DHCP subnet object for each of the subnets
for which you want to assign addresses:

1. In the DNS/DHCP Management Console, click the DHCP Service tab.

2. Select Our Network or the DHCP Server Object.

3. Click Create. The Create New DHCP Object window opens.

4. Select Subnet; then, click OK. The Create Subnet window opens.

5. For each subnet, type the following information:

28 IBM FAStT Storage Manager Version 8.21: Installation and Support Guide for Linux



v Subnet name

v NDS context

v Subnet address

v Subnet mask

v Default DHCP Server

6. Click Create. The DHCP subnet object is created and displayed in the
DNS/DHCP Management Console.

Creating subnet address ranges
Do the following to create a subnet address range object:

1. From the DNS/DHCP Management Console, click the DHCP Service tab.

2. Select the subnet object under which you want to create the subnet address
range object; then, click Create. The Create New DHCP Record window opens.

3. Select Subnet Address Range; then, click OK. The Create New Subnet
Address Range window opens.

4. Type the following information for the subnet address range:

v Subnet address range name

v Starting address

v Ending address

5. Click Create.

6. Select the Define Additional Properties check box; then, set the Range Type
to Dynamic BOOTP and DHCP.

Creating IP address objects
Use the DNS/DHCP Management Console to create IP address objects. IP address
objects are used for the following purposes:

v To exclude an IP address from assignment

v To assign an IP address manually to a specific host

v To record dynamic IP address leases

Do the following to create an IP address object:

1. From the DNS/DHCP Management Console, click the DHCP Service tab.

2. Select the subnet object of the target IP address; then, click Create.

3. Select IP Address; then, click OK. The Create IP Address window opens.

4. In the IP Address field, type the IP address for the first controller.

5. In the Assignment field, select Manual.

6. In the Client Identifier field, specify the MAC address.

7. In the MAC Address field, enter the hardware Ethernet MAC address for the
controller.

8. Select the Define Additional Properties check box.

9. In the Host name field, type the eight-character name for the controller.

10. In the Usage field, select Permanent.

11. Repeat step 3 through step 10 for each controller.

Starting the DHCP server
To start the DHCP server, type the following at the DHCP server console:
LOAD DHCPSRVR

The DHCP server can now respond to client requests and assign IP addresses.
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Notes:

1. To load the DHCP server automatically each time the server starts, place the
DHCPSRVR command in the SYS:\SYSTEM\AUTOEXEC.NCF directory.

2. For additional information about setting up, configuring, or using Novell
DNS/DHCP Services, refer to the NetWare 5.1 documentation, located on the
Novell Documentation CD or go to the http://www.novell.com/documentation
Web site.

Setting up a UNIX BOOTP server
To use a UNIX BOOTP server, you must set up a BOOTP table. Table 10 and the
information record (Table 12 on page 49) provide the information needed.

Table 10. Required entries for setting up the UNIX BOOTP server

Entry Description Sample format in
BOOTP server

Subnet mask Mask that is used to route packets to defined
subnets

dot notation
(sm=255.255.255.0)

Router IP address of the host computer that routes
packets to networks

dot notation
(gw=192.168.128.1)

Host name for the
controller

Host name that is associated with the controller
(refer to Table 12 on page 49)

host name (Denver_a)

IP address IP address of the controller (refer to Table 12
on page 49)

dot notation
(ip=192.168.128.101)

Ethernet address The Ethernet address of the controller
hardware (refer to Table 12 on page 49)

hexadecimal notation
(ha=00a0b8020420)

To set up a UNIX BOOTP server, do the following:

1. Use a text editor to edit the bootptab file in the /etc directory.

The following is an example of the BOOTP table used to configure a network
s4.default:\ (common settings)

ht=ether:\

sm=255.255.248.0:\

gw=192.168.128.1:\

hn:

denver_a:\

tc=s4.default:\ (common settings)

ip=192.168.128.101:\

ha=00a0b8020420:

denver_b:\

tc=s4.default:\

ip=192.168.128.102:\

ha=00a0b80000d8:

where the s4.default:\ entry denotes settings that are common to all controllers,
and the tc=s4.default:\ entry associates this common setting group to a specific
controller.

2. If the storage subsystem is running, shut down and then restart the subsystem.
This will ensure that the parameters in the BOOTP table take effect.

3. Continue with “Verifying the TCP/IP protocol and setting up the host or DNS
table” on page 31.
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Verifying the TCP/IP protocol and setting up the host or DNS table
Make sure that the host names for the controller match the IP addresses for the
controllers. Use the following procedure to verify that the TCP/IP-protocol software
is installed on the management station, and to set up the host or DNS (Domain
Name System) table.

1. Update either the host table or DNS table to specify a host name to associate
with an IP address. If you do not have a DNS, edit the host table found in the
following directory (your directory might be different if the operating system is
not installed on the root).
/etc/hosts

2. To manage storage subsystems through a firewall, configure the firewall to open
port 2463 to TCP data.

The following is a sample of a Linux host file. Do not remove the following line, or
various programs that require network functionality will fail.
127.0.0.1 rh71_8500 localhost.localdomain localhost 102.54.94.97 rhino.acme.com x.acme.com
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Chapter 3. Installing software

This chapter describes how to install the storage-management software.

Important: Always check for a README file on any installation media. This
README file might contain important information that was not available when this
Installation and Support Guide was written.

New installation process
To begin installing the storage-management software, ensure that the network
components are set up and operating properly, and that you have all the host and
controller information needed for the software to operate. Be sure to install the
software on the management stations as well as the attached host computers.

Use the following task list as a guide for installing the software on a standard
configuration.

1. Uninstall the earlier version Storage Manager (use this procedure when
installing Storage Manager 8.21 on an existing storage subsystem).

2. Install Storage Manager 8.21 Runtime.

3. Verify the installation of the Storage Manager 8.21 Runtime.

4. Install Storage Manager 8.21 Utility.

5. Verify the installation of the Storage Manager 8.21 Utility.

6. Install Storage Manager Client 8.21 Client.

7. Verify the installation of Storage Manager Client 8.21 Client.

8. Disable and enable the Event Monitor.

9. Uninstall IBM FAStT Management Suite Java (use this procedure when
installing Storage Manager 8.21 on an existing storage subsystem).

10. Install IBM FAStT Management Suite Java.

11. Install the IBM Host Adapter (HA) device driver (qla2200.o or qla2300.o)
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Uninstalling Storage Manager
To uninstall Storage Manager, do the following:

Note: You do not need to restart your host computer after removing a software
component. During the software removal process, the host keeps existing
storage subsystem mappings and storage partition configurations, which the
new client software will recognize.

1. Be sure you have root privileges, which are required to perform this
uninstallation procedure.

2. To begin uninstalling Storage Manager, type:
rpm -qa|grep SM

3. Press Enter. The SM packages are listed.

4. At the prompt, type the following and press Enter:
rpm -e component-name

Where component-name is the name of the storage-management software
package that you want to uninstall. The system prompt displays when the
software removal completes.

5. Verify that the removal was successful. At the system prompt, type the following
and press Enter:
rpm -qi component-name

Where component-name is the name of the storage-management software
package that you want to uninstall. If the uninstallation process was successful,
the host will display a message indicating that the software is not installed.

6. Repeat steps 2 through 4 to remove each Storage Manager component and
associated directory.

7. Click Completed in the Installation Activity pane.

8. Do one of the following three options:

v If you are installing a management station, go to “Installing the Storage
Manager 8.21 software package”.

v If you are installing IBM FAStT Storage Manager Version 8.21 on a host
computer, go to “Installing the Storage Manager 8.21 software package”.

v If you remove the storage-management software and do not plan to reinstall
the software on a management station or host computer, you have
successfully completed all procedures.

Installing the Storage Manager 8.21 software package
Use the procedures in this section to install the software package on a
management station or host computer.

Installing Storage Manager 8.21 Runtime
To install SMRuntime, do the following:

1. Close all open programs.

2. Insert the IBM FAStT Storage Manager Version 8.21 CD into the CD-ROM
drive.

3. To mount the CD-ROM, type the following and press Enter:
mount /mnt/cdrom

4. Type the following and press Enter:
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cd /mnt/cdrom/linux

5. Type the following:
rpm -ivh SMruntime

6. Press Tab; then, press Enter.

Verifying the Storage Manager 8.21 Runtime installation
To verify that the installation was successful, do the following:

1. At the system prompt, type the following and press Enter:
rpm -qi SMRuntime

The verification process displays a message that describes the SMRuntime
software, including version numbers, copyright license, installation time, and
general software package description.

If no failure is reported, go to step 2. If the verification reports a failure, repeat
steps 1 through 6 of the installation procedure.

2. Continue with “Installing the Storage Manager 8.21 Client”.

Installing the Storage Manager 8.21 Client
To install the SMclient, do the following:

1. Close all open programs.

2. Insert the IBM FAStT Storage Manager Version 8.21 CD into the CD-ROM
drive.

3. To mount the CD-ROM, type the following and press Enter:
mount /mnt/cdrom

4. Type the following and press Enter:
cd /mnt/cdrom/linux

5. Type the following:
rpm -ivh SMclient

6. Press Tab; then, press Enter.

Verifying the Storage Manager 8.21 client installation
To verify that the installation was successful, do the following:

1. At the system prompt, type the following and press Enter:
rpm -qi SMclient

The verification process displays a message that describes the SMclient
software, including version numbers, copyright license, installation time, and
general software package description.

If no failure is reported, continue to step 2. If the verification reports a failure,
repeat steps 1 through 6 of the installation procedure.

2. Continue the installation with “Installing IBM FAStT Management Suite Java” on
page 37 if you are installing a new storage subsystem. If you are installing the
storage-management software on an existing storage subsystem, continue with
“Disabling and enabling the Event Monitor”.

Disabling and enabling the Event Monitor
The Event Monitor, which comes with the client software, is installed automatically
during the client software installation. The Event Monitor handles storage
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subsystem error notification through e-mail or SNMP traps when the
storage-management software is not actively running on the storage-management
station or host computer.

Important: If you have installed the client software on multiple hosts, you might
receive duplicate error messages from the same storage subsystem. To avoid
receipt of duplicate error messages, disable the Event Monitor on all but one
system. You must run the Event Monitor on one host that will run continually.

To disable the Event Monitor, type the following and press Enter:
/etc/rc.d/init.d/SMmonitor stop

To enable the Event Monitor, type the following and press Enter:
/etc/rc.d/init.d/SMmonitor start

Installing the Storage Manager 8.21 Utility
To install the SMutility, do the following:

1. Close all open programs.

2. Insert the IBM FAStT Storage Manager Version 8.21 CD into the CD-ROM
drive.

3. To mount the CD-ROM, type the following and press Enter.
mount /mnt/cdrom

4. Type the following and press Enter:
cd /mnt/cdrom/linux

5. Type the following:
Type rpm -ivh SMutil

6. Press Tab; then, press Enter.

Verifying the Storage Manager 8.21 Utility installation
To verify that the installation was successful, do the following:

1. At the system prompt, type the following and press Enter:
rpm -qi SMutility

The verification process displays a message that describes the SMutility
software.

If no failure is reported, continue to step 2. If the verification reports a failure,
repeat steps 1 through 6 of the installation procedure.

2. Continue with “Uninstalling IBM FAStT Management Suite Java”.

Uninstalling IBM FAStT Management Suite Java
If you are installing Storage Manager 8.21 in an environment with existing storage
subsystems, you need to uninstall older versions of IBM FAStT Management Suite
Java and then install the version of IBM FAStT Management Suite Java that came
on the IBM FAStT Storage Manager Version 8.21 CD.

To uninstall FAStT MSJ, do the following:

1. From a command prompt, type the following:
/usr/FAStT_MSJ_Uninstaller

2. Press Tab; then, press Enter.
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Installing IBM FAStT Management Suite Java
The IBM FAStT Management Suite Java (FAStT MSJ) software includes the FAStT
GUI device driver that is required for failover support. You can use the GUI to
configure logical drives, storage, and failover.

Note: For additional information, refer to the online help.

To install IBM FAStT Management Suite Java, do the following:

1. Insert the IBM FAStT Storage Manager Version 8.21 CD into the CD-ROM
Drive.

2. From the X-windows GUI, open a command window.

3. Type the following and press Enter:
cd /mnt/cdrom/FAStT_MSJ/linux

4. To run the installer for FAStT MSJ, type the following at a prompt:
sh FAStT

5. Press Tab; then, press Enter. The Introduction window opens.

6. Click Next.

7. Start your Linux server again.

8. Continue with “Installing the IBM Host Adapter device driver (qla2200.o or
qla2300.o)”.

For additional configuration information, refer to the IBM FAStT MSJ User’s Guide.

Installing the IBM Host Adapter device driver (qla2200.o or qla2300.o)
The IBM Host Adapter device driver enables the operating system to communicate
with the host adapter. The IBM FAStT Host Adapter, IBM FAStT FC-2 Host Bus
Adapter, and IBM TotalStorage FAStT FC2-133 Host Bus Adapter are
high-performance, direct memory access (DMA), bus-master, host adapters that are
designed for high-end systems. These host bus adapters support all Fibre Channel
(FC) peripheral devices that support private-loop direct attach (PLDA) and
fabric-loop attach (FLA). For more information, refer to the IBM FAStT Host Adapter
Installation and User’s Guide, IBM FAStT FC-2 Host Bus Adapter Installation and
User’s Guide, or the IBM TotalStorage FAStT FC2-133 Host Bus Adapter
Installation and User’s Guide. Go to the http://www.ibm.com/pc/support IBM Web
page for the current README file and latest multipath I/O device driver.
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Chapter 4. Completing the installation

This chapter contains procedures for using Enterprise Management and Subsystem
Management to complete the following installation tasks:

1. Perform an initial automatic discovery of storage subsystems.

2. Add devices.

3. Set up alert notifications.

4. Name the storage subsystems.

5. Download firmware and NVSRAM.

6. Create arrays and logical drives.

7. Define host-types.

8. Configuration of heterogeneous hosts.

9. Identifying logical drives by operating system device names.

10. Perform other storage subsystem tasks.

The Enterprise Management window opens when you start FAStT Storage
Manager. Use the Enterprise Management window to do the following:

v Add and discover the storage subsystems

v View all storage subsystems in your management domain

v Perform batch storage subsystem management tasks using the Script Editor

Performing an initial automatic discovery of storage subsystems
To perform an initial automatic discovery of storage subsystems, do the following:

1. At the command prompt type:
SMclient

Note: If /opt/SMclient is not contained in the path environment, the full path
name is required on the command line:
/opt/IBM_FAStT/client/SMclient
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Note: The Enterprise Management window might take several minutes to open.
No wait cursor is displayed.

2. Click Yes to begin an initial automatic discovery of hosts and storage
subsystems attached to the local subnetwork.

After the initial automatic discovery is complete, the Enterprise Management
window displays all hosts and storage subsystems attached to the local
subnetwork.

Figure 14. Confirm Initial Automatic Discovery window
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Note: The Enterprise Management window might take up to a minute to refresh
after an initial automatic discovery.

3. Verify that each host and storage subsystem is displayed in the Enterprise
Manager window.

If a host or storage subsystem is not displayed, do the following:

v Check the hardware and connections for possible problems (refer to the
hardware documentation for specific procedures).

v Refer to the Enterprise Management online help for additional information
about discovering storage subsystems.

v Verify that all hosts and storage subsystems are on the local subnetwork. If
they are not, use the Add Device option.

Note: In certain situations, a storage subsystem might be duplicated in the
device tree after an automatic discovery. You can remove a duplicate
storage-management icon from the device tree by using the Remove
Device option in the Enterprise Management window.

4. Verify that the status of each storage subsystem is Optimal. If a device shows a
status of Unresponsive, use the software to remove the device from the
management domain and then add it again. Refer to the Enterprise
Management window online help for instructions on removing and adding
devices.

5. Continue with “Adding devices”.

Adding devices
You can add more hosts or storage subsystems outside the local subnetwork. For
more information about this option, refer to the Enterprise Management window
online help.

Figure 15. Enterprise Management window
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Important: When you add new storage subsystems to existing storage subsystems
that are managed using the direct-management method, be sure to specify the IP
addresses for both controllers.

Continue with “Setting up alert notifications”.

Setting up alert notifications
After you add devices to the management domain, you can set up alert notification
to report critical events on the storage subsystems. The following alert-notification
options are available:

v Notification to a designated network management station (NMS) using Simple
Network Management Protocol (SNMP) traps

v Notification to designated e-mail addresses

v Notification to designated alphanumeric pagers (requires additional software to
convert e-mail messages)

Note: If you do not install Event Monitor, you must monitor storage subsystems
within the management domain. The Enterprise Management window must
remain open; if you close the window, you will not receive alert notifications.
Refer to the Enterprise Management window online help for additional
information.

To set up alert notification to an NMS using SNMP traps, do the following:

1. Insert the IBM FAStT Storage Manager Version 8.21 CD into the CD-ROM drive
on a network management station (NMS). You need to set up the designated
management station only once.

2. Copy the SM8.MIB file from the SM8mib directory to the NMS.

3. Follow the steps required by your NMS to compile the management information
base (MIB) file. (For details, contact your network administrator or see the
documentation specific to the storage management product you are using.)

4. Continue with “Naming storage subsystems”.

Naming storage subsystems
To name your storage subsystem, do the following:

1. In the Enterprise Management window, select a storage subsystem.
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2. Click Tools → Manage Device. The Subsystem Management window opens, as
shown in Figure 16.

3. Click Storage Subsystem → Rename. The Rename Storage Subsystem
window opens.

4. Type the name of the storage subsystem (refer to Table 12 on page 49); then,
click OK.

5. Repeat for each unnamed storage subsystem. For more information, refer to the
topic on renaming storage subsystems in the Subsystem Management window
online help.

6. Continue with “Downloading firmware and NVSRAM”.

Downloading firmware and NVSRAM
This section provides instructions for downloading firmware and NVSRAM. You
must download firmware version 5.2x.xx.xx before you download NVSRAM.

Downloading firmware
To download firmware version 5.2x.xx.xx, do the following:

1. From the Enterprise Management window, select a storage subsystem.

2. Click Tools → Manage Device. The Subsystem Management window opens.

3. Click Storage Subsystem → Download → Firmware. Follow the on-screen
instructions.

4. Continue with “Downloading NVSRAM”.

Downloading NVSRAM
To download NVSRAM, do the following:

1. From the Enterprise Management window, select a storage subsystem.

2. Click Tools → Manage Device. The Subsystem Management window opens.

3. Click Storage Subsystem → Download → NVSRAM. Follow the on-screen
instructions.

Figure 16. Subsystem Management window
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4. Continue with “Creating arrays and logical drives”.

Creating arrays and logical drives
A logical drive is the basic structure you create to store data on the storage
subsystem. The operating system recognizes a logical drive as a single drive.
Choose a RAID level to meet application needs for data availability and maximize
Fibre Channel I/O performance.

To create arrays and logical drives, do the following:

1. From the Enterprise Management window, select a storage subsystem.

2. Click Tools → Manage Device. The Subsystem Management window opens.

3. Click the Logical/Physical View tab.

4. Click Logical Drive → Create. The Logical Drive Create wizard starts. Follow
the online instructions to create arrays and logical drives.

5. Continue with “Defining the default host type”.

Note: (For cluster configurations) If you add or delete logical drives, you must
make them known to both node A and node B.

Defining the default host type
Before using the logical drives in a host computer, you must specify the host type.
The host type determines how the storage subsystem controllers will work with
each particular operating system on the hosts to which it is connected. If all of the
host computers connected to the same storage subsystem have the same operating
system installed, and you do not want to define partitioning, you can define a
default host type.

To define a default host type, do the following:

1. Click Storage subsystem → Change → Default host-type. The Default
Host-type window opens.

2. From the pull-down menu, select the host type.

3. Click OK.

If you have hosts with different operating systems or if you want to define partitions
for the hosts, continue with “Configuring heterogeneous hosts”.

Configuring heterogeneous hosts
The heterogeneous hosts feature enables hosts that run operating systems to
access a single storage subsystem. Previous releases of IBM FAStT Storage
Manager (versions 7.02 or earlier) required that hosts run the same operating
system in order to access a single storage subsystem.

Host computers can run completely different operating systems (for example,
Solaris and Windows NT) or variants of the same operating system (for example,
Windows NT running in a cluster environment or Windows NT running in a
noncluster environment). When a host type is specified in the Define New Host Port
window, the heterogeneous hosts feature enables the controllers in the storage
subsystem to tailor their behavior (such as LUN reporting) to the needs of the host.

Important: To use the heterogeneous host feature, the following conditions must be
met:
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v Storage partitioning is enabled.

v During host-port definition, you must set each host type to the appropriate
operating system so that the firmware on each controller can respond correctly to
the host.

To start the heterogeneous host configuration, do the following:

1. From the Subsystem Management window, click Configure → Storage
Partition.

2. Follow the on-screen instructions.

3. To display the association between a storage subsystem and operating system
device name, continue with “Identifying logical drives by operating system
device names”. Otherwise, continue with “Performing other storage-subsystem
management tasks”.

Note: Partitioning is a premium feature. If you disable partitioning and you did not
save a copy of your key file to disk, you must contact your IBM
technical-support representative to obtain a key to re-enable partitioning.

Identifying logical drives by operating system device names
The SMutil software package includes a utility that lets you see which storage
subsystem logical drive is associated with a particular operating system device
name. This capability is useful for operations such as data placement and logical
drive deletion.

Type the following and press Enter:
SMdevices

The software displays device identification information similar to the following,
where:

v /dev/... = Linux device node name

v Storage subsystem = storage subsystem name

v Logical drive = logical drive name

v LUN = logical unit number associated with the logical drive

v WWN = world wide name for the logical drive
/dev/sdb (/dev/sgc)[Storage subsystem <name>, Logical drive 1, LUN 0,
Logical drive WWN<600a0b8000091c9c000000df3bcedaae>, Alternate Path:
In Use]
/dev/sdc (/dev/sgc) [Storage subsystem <name>, Logical drive 2, LUN 1,
Logical drive WWN <600a0b8000091c9c000000e33bcedb05>, Alternate Path:
Not In Use]
/dev/sdd (/dev/sgc)[Storage subsystem <name>, Logical drive 3, LUN 2,
Logical drive WWN <600a0b8000091c9c000000e73bcedb5c>, Alternate Path:
In Use]

Performing other storage-subsystem management tasks
Other storage subsystem management tasks you can perform include the following:

v Locating a storage subsystem

v Viewing a storage subsystem profile

v Entering or changing a storage subsystem password

v Creating and managing of logical drives and subsystems

v Using the Performance Monitor
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v Creating storage partitions (if applicable) and heterogeneous hosts

Note: To create storage partitions, you must obtain the worldwide name or port
name of each host adapter in every host connected to the storage
subsystem.

For more information about these and other storage subsystem management tasks,
refer to the appropriate topics in the Subsystem Management online help.

46 IBM FAStT Storage Manager Version 8.21: Installation and Support Guide for Linux



Chapter 5. Linux operating-system support

This chapter contains information that is specific to operating the
storage-management software in a Linux environment.

Supported logical drives
The supported logical drive limits are as follows:

v When using Linux Storage Management Services (SMS), you can configure up to
128 LUNs or the maximum for the host adapter model.

v Host adapters support a specific number of logical drives. Refer to the
host-adapter documentation for specific information.

Linux limitations
Important: Always check for a README file on any installation media. This
README file contains information that was not available when this Installation and
Support Guide was prepared.

Table 11 explains the limitations that apply when you use the IBM FAStT Storage
Manager Version 8.21 in a Linux operating system environment.

Table 11. Linux limitations and workarounds

Limitations Workaround

Vixel Rapport 2000 Fibre Channel hubs using
controllers with firmware version 04.01.02
cause problems, including damage to data,
system instability, and disrupted loop activity.

Do not use Vixel Rapport 2000 Fibre Channel
hubs when your system is operating in a
controller or an I/O path fault-tolerant
environment.

The maximum number of physical drives that
can be in a single RAID 5 logical drive is 29.
The maximum number of physical drives that
can be in a single RAID 1 logical drive is 28.

None.

After removing all drives from a storage
subsystem, you are prompted for a password
at software startup or when you perform
protected operations, all passwords you enter
fail.

Add one of the drives to the storage
subsystem and attempt the operation again.

Removing a set of drives that are configured
with logical drives from one storage
subsystem for insertion into another storage
subsystem, is not supported because it might
cause loss of configuration.

Contact an IBM technical support
representative for assistance.

A standard non-network configuration is not
supported when the Linux host does not have
the TCP/IP software installed.

Install the TCP/IP software on the Linux host
computer and assign the host a static IP
address.

Multipath failover will work if the storage
controllers are in only active/active mode.

When you configure the storage subsystem,
change both controllers to active status.

When you configure a new storage
subsystem with a single controller, you must
place the controller in slot A.

The controller firmware does not recognize or
communicate with a single controller until slot
A is populated. This restriction does not apply
to storage subsystems that were originally
configured with two controllers.
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Table 11. Linux limitations and workarounds (continued)

Limitations Workaround

Your windows and online help display a
brownish hash pattern when you run in 256
color mode.

Run the Storage Manager 8 application in a
higher display mode.

When performing a redundancy check (parity
scan) from the storage-management
application, machine type 3542 can take
several minutes longer than machine type
1742 and 3552 controller platforms.

None.

You might not see the maximum number of
drives during Automatic Configuration if you
are using drives of different capacities.

Use Manual Configuration to select individual
drives and select the maximum number of
drives allowed.

When you connect an IBM TotalStorage
FAStT EXP700 Storage Expansion Unit to a
FAStT200, the drive speed must be set to 1
GB per second.

None.
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Appendix A. Storage subsystem/controller information record

Table 12 provides a data sheet where you can record storage subsystem names,
hardware Ethernet addresses, and IP addresses. Make a copy of this table and
complete the information for your storage subsystems and controllers. Use the
information that is recorded in Table 12 to set up the BOOTP table for the network
server and the host or Domain Name System (DNS) table. The information in
Table 12 will help you add storage subsystems after your initial installation. The
column headings show a page reference for detailed instructions about obtaining
the information. For a sample information record, refer to “Reviewing a sample
network” on page 15.

Table 12. Storage subsystem information record and controller information record

Storage subsystem
name (refer to page 16)

Controllers—Ethernet and IP
addresses, and host name (refer to
pages 17 and 20)

Host—IP address
and host name
(refer to page 20)
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Appendix B. Getting help and technical assistance

If you need help, service, or technical assistance or just want more information
about IBM® products, you will find a wide variety of sources available from IBM to
assist you. This appendix contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your xSeries™ or IntelliStation® system, and whom to call for service, if it is
necessary.

Before you call
Before you call, make sure that you have taken these steps to try to solve the
problem yourself:

v Check all cables to make sure that they are connected.

v Check the power switches to make sure that the system is turned on.

v Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system.

v Go to the IBM Support Web site at http://www.ibm.com/pc/support/ to check for
technical information, hints, tips, and new device drivers.

v Use an IBM discussion forum on the IBM Web site to ask questions.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
publications that are provided with your system and software. The information that
comes with your system also describes the diagnostic tests that you can perform.
Most xSeries and IntelliStation systems, operating systems, and programs come
with information that contains troubleshooting procedures and explanations of error
messages and error codes. If you suspect a software problem, see the information
for the operating system or program.

Using the documentation
Information about your IBM xSeries or IntelliStation system and preinstalled
software, if any, is available in the documentation that comes with your system.
That documentation includes printed books, online books, README files, and help
files. See the troubleshooting information in your system documentation for
instructions for using the diagnostic programs. The troubleshooting information or
the diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to http://www.ibm.com/pc/support/ and follow the
instructions. Also, you can order publications through the IBM Publications Ordering
System at
http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi.

Getting help and information from the World Wide Web
On the World Wide Web, the IBM Web site has up-to-date information about IBM
xSeries and IntelliStation products, services, and support. The address for IBM
xSeries information is http://www.ibm.com/eserver/xseries/. The address for IBM
IntelliStation information is http://www.ibm.com/pc/intellistation/.
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You can find service information for your IBM products, including supported options,
at http://www.ibm.com/pc/support/. If you click Profile from the support page, you
can create a customized support page. The support page has many sources of
information and ways for you to solve problems, including:

v Diagnosing problems, using the IBM Online Assistant

v Downloading the latest device drivers and updates for your products

v Viewing Frequently Asked Questions (FAQ)

v Viewing hints and tips to help you solve problems

v Participating in IBM discussion forums

v Setting up e-mail notification of technical updates about your products

Software service and support
Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with xSeries servers, IntelliStation
workstations, and appliances. For information about which products are supported
by Support Line in your country or region, go to
http://www.ibm.com/services/sl/products/.

For more information about Support Line and other IBM services, go to
http://www.ibm.com/services/, or go to http://www.ibm.com/planetwide/ for support
telephone numbers.

Hardware service and support
You can receive hardware service through IBM Integrated Technology Services or
through your IBM reseller, if your reseller is authorized by IBM to provide warranty
service. Go to http://www.ibm.com/planetwide/ for support telephone numbers.

In the U.S. and Canada, hardware service and support is available 24 hours a day,
7 days a week. In the U.K., these services are available Monday through Friday,
from 9 a.m. to 6 p.m.
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Appendix C. Notices

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Edition notice
© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2002.
All rights reserved.

Note to U.S. Government Users — Documentation related to restricted rights —
Use, duplication or disclosure is subject to restrictions set forth in GSA ADP
Schedule Contract with IBM Corp.
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Trademarks
The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

e-business logo Predictive Failure Analysis
FlashCopy Redbooks
IBM ServeRAID
IntelliStation ServerProven
Netfinity TotalStorage

Lotus, Lotus Notes, and Domino are trademarks of Lotus Development Corporation
and/or IBM Corporation in the United States, other countries, or both.

Intel, Celeron, MMX, LANDesk, Pentium, Pentium II Xeon, Pentium III Xeon, and
Xeon are trademarks of Intel Corporation in the United States, other countries, or
both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds.

Other company, product, or service names may be the trademarks or service marks
of others.

Important notes
Processor speeds indicate the internal clock speed of the microprocessor; other
factors also affect application performance.

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often
less than the maximum possible.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000
bytes, and GB stands for approximately 1 000 000 000 bytes.

When referring to hard disk drive capacity or communications volume, MB stands
for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible
capacity may vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the largest
currently supported drives available from IBM.

Maximum memory may require replacement of the standard memory with an
optional memory module.
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IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven®, including but not limited to the implied warranties
of merchantability and fitness for a particular purpose. These products are offered
and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software may differ from its retail version (if available), and may not include
user manuals or all program functionality.
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Red Hat Linux (continued)
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